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Messung des Lichtschwerpunktabstands von 
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Application Note, AN RIGO 001, 2022-11-09 

In dieser Application Note wird die Messung des Lichtschwerpunktabstands am Beispiel einer LED 

Signallampe vom Typ LY5B unter Verwendung eines Nahfeldgoniophotometers vom Typ RiGO801 – 

LED erläutert. Das auf der Auswertung von Strahlendaten basierende Verfahren ist in der Norm IEC 

60809:2021 [1] aufgeführt. 

Inhaltsverzeichnis 

Messung von Strahlendaten mit dem Nahfeldgoniophotometer RiGO801 – LED .................................. 1 

Berechnung des Lichtschwerpunktabstands nach IEC 60809:2021 ........................................................ 2 

Messung des Lichtschwerpunkts einer LY5B LED Signallampe ............................................................... 3 

Positionierung der Lampe im Goniophotometer ................................................................................ 3 

Messparameter ................................................................................................................................... 4 

Stabilisierungsphase ............................................................................................................................ 4 

Messergebnisse ................................................................................................................................... 5 

Vorbereitung der Strahlendaten ......................................................................................................... 5 

Öffnen der TTR Datei ....................................................................................................................... 5 

Festlegen der Zielgeometrie ............................................................................................................ 5 

Einbetten der Parameter in die TTR Datei ...................................................................................... 8 

Berechnung des Lichtschwerpunktabstands ....................................................................................... 8 

Betrachtungen zur Messunsicherheit ..................................................................................................... 9 

Zusammenfassung ................................................................................................................................... 9 

Verweise ................................................................................................................................................ 11 

 

  



 

Application Note 

 

 

E-Mail: info@technoteam.de Website: www.technoteam.de 1 

 

Messung von Strahlendaten mit dem Nahfeldgoniophotometer RiGO801 – LED 

Alle RiGO801 Goniophotometer basieren auf dem Nahfeldmessprinzip. Eine 

Leuchtdichtemesskamera erfasst die komplette räumliche Leuchtdichteverteilung einer Lichtquelle. 

Aus diesen Daten werden auf Basis des photometrischen Grundgesetztes Strahlendaten und die 

Lichtstärkeverteilung abgeleitet (siehe [2], [3], [4], [5], [6]). Dieses Messverfahren ist unabhängig von 

der photometrischen Grenzentfernung und ermöglicht daher kleine Messabstände und kompakte 

Goniophotometer. 

 

Als Strahlendaten (auch ray data oder ray file) wird ein Datensatz von Vektoren mit zugeordneten 

Lichtstromanteilen bezeichnet. Eine ausreichend hohe Anzahl von Strahlen repräsentiert die 

komplette Abstrahlcharakteristik einer Lichtquelle mit hoher Genauigkeit. Diese Daten werden daher 

vielfach zur realitätskonformen Simulation von optischen Komponenten verwendet. 

Das Goniophotometer vom Typ RiGO801 – LED ist 
speziell für die Messung von Strahlendaten von LEDs 
und LED Modulen konzipiert. Die 
Leuchtdichtemesskamera LMK 6-5 wird auf einem 
Kreisbogen (Theta-Achse) um das auf der stehenden 
Rotationsachse (Phi-Achse) montierte Messobjekt 
bewegt. 

Die Messung eines Strahls ist beispielhaft in 
Abbildung 2 illustriert. Ein Pixel des Bildsensors 
definiert zusammen mit dem Zentrum des Objektivs 

den Startpunkt  , ,x y zP P P  und die Richtung 

 , ,x y zn n n  des Strahls. Der Lichtstromanteil   

wird aus der Leuchtdichte des Pixels und des 
korrespondierenden Raumwinkels berechnet. 

 

Abbildung 1: RIGO801 - LED 

Die Strahlen aus allen Leuchtdichtebildern ergeben den Strahlendatensatz. Zunächst liegen die 

Startpunkte aller Strahlen auf der Kugelfläche, die durch die Kamera beschrieben wird. Zur 

günstigeren Verarbeitung der Strahlen in der Optiksimulation werden die Startpunkte mittels 

Raytracing auf eine Hüllfläche um die Lichtquelle (Zielgeometrie) verschoben (Abbildung 3). In 

Abbildung 4 ist ein auf eine dünne Kreisscheibe berechneter Strahlendatensatz als 3D Vektorfeld 

dargestellt. 
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Abbildung 2: Messung eines Strahls 

 

Abbildung 3: Raytracing auf Zielgeometrie 

Die Strahlendaten werden mit dem kostenlosen Programm 
Konverter801 aufbereitet. Neben dem Export der Daten in alle 
gängigen Dateiformate können verschiedene Auswertungen 
vorgenommen werden, beispielsweise die Berechnung des 
Lichtschwerpunkts bzw. des photometrischen Schwerpunkts. 

Weitere Information sind auf unserer Webseite verfügbar: 
http://www.technoteam.de/ 

 

Abbildung 4: Strahlendatensatz 

Berechnung des Lichtschwerpunktabstands nach IEC 60809:2021 

Im Anhang K.1 der Norm IEC 60809:2021 wird ein Verfahren 
zur Messung des Lichtschwerpunktabstands e für LED 
Lampen der Typen Lx3A, Lx3B, Lx4A, Lx4B, Lx5A, Lx5B8), 
L1A/6 und L1B/6 beschrieben. 

Der Lichtschwerpunktabstand wird aus gemessenen 
Strahlendaten berechnet. Der Lichtschwerpunkt ist definiert 
als der Ort, an dem die Summe der quadratischen Abstände 
der Strahlvektoren minimal ist.  

Die Abstände der Strahlen (Index i , Startpunkt p , Richtung 

r ) zu einem Punkt c  ist definiert durch 

 

Abbildung 5: Lichtschwerpunktabstand e 
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Gesucht ist der Punkt c , für den folgende Beziehung gilt 

 2min .i

i

d
c

 (2) 

Das Minimierungsproblem wird mit der Methode der kleinsten Quadrate gelöst [1]. Das System vom 

Gaußschen Normalgleichungen ergibt sich aus 

 2 0i

i

d  . (3) 
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In Abbildung 6 wird die Lage des Lichtschwerpunkts eines 
Strahlendatensatzes beispielhaft gezeigt. 

Durch die quadratische Bewertung der Abstände, können 
Ausreißer in den Messdaten die Ergebnisse der 
Ausgleichsrechnung stark beeinflussen. Daher ist es 
notwendig, z.B. durch Rauschen entstandene Strahlen bei 
der Ausgleichsrechnung zu eliminieren. Weiterhin sind 
natürlich die Lichtstromanteile der Strahlen als Gewichte 
zu berücksichtigen.  

Abbildung 6: Strahlen mit Lichtschwerpunkt 

In der IEC 60809:2021 wird eine Mindestanzahl von 1 Million Strahlen genannt. Die Winkelauflösung 

der für die Strahlendatenmessung zugrundeliegenden Leuchtdichtebilder muss mindestens 1° x 1° 

betragen. 

Messung des Lichtschwerpunkts einer LY5B LED Signallampe 

Zur Messung von LED Lampen der Typen Lx3A, Lx3B, Lx4A, Lx4B, Lx5A, Lx5B8, L1A/6 und L1B/6 ist das 

Goniophotometer RiGO801 – LED sehr gut geeignet. Im Folgenden wird gezeigt, wie eine LY5B LED 

Signallampe mit diesem System gemessen werden kann. 

Positionierung der Lampe im Goniophotometer 
Wie in Abbildung 5 gezeigt, ist der Abstand e die Distanz zwischen der Referenzebene und dem 

Lichtschwerpunkt. Die Lage der Referenzebene und der Referenzachse in Bezug zum 

Koordinatensystem des Goniometers – und damit der Strahlendaten – muss genau bekannt sein. 

Die Ausrichtung und Positionierung der Lichtquelle wird mit Hilfe des im Kamerabild eingeblendeten 

Koordinatensystems durchgeführt. Die gewünschten Referenzmerkmale des Messobjekts müssen 

dabei natürlich im Kamerabild klar erkennbar sein. Hierbei sind die Einflüsse der Tiefenschärfe und 

der Verzeichnung des verwendeten Objektivs sowie der perspektivischen Verzerrung zu 

berücksichtigen. Die Erfassung der Referenzmerkmale der oben aufgeführten Lampentypen direkt im 

Kamerabild stellt hier schon höhere Anforderungen. Für eine bequeme Messung mit hoher 

Genauigkeit empfiehlt es sich daher, eine spezielle Referenz-Messhalterung mit einem passenden 

Lampensockel zu verwenden, die mit geeigneten Markierungen versehen ist. 

Für den hier gezeigten Messablauf musste improvisiert werden, da keine spezielle Messfassung 

verfügbar war. Es wurde ein Objektiv mit einem größeren Bildfeld von 35 mm und dementsprechend 

großer Tiefenschärfe verwendet, um die gesamte LY5B Lampe inklusive Fassung abbilden zu können. 

Die Referenzebene wurde genau in die X/Y Ebene (Z=0) des Goniometers gelegt. Die folgenden 

Abbildungen zeigen das Messobjekt im Goniometer und die Justagebilder aus Kameraperspektive. 
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Abbildung 7: Position im Goniometer Abbildung 8: Justagebild - Top View Abbildung 9: Justagebild - 
Seitenansichten 

Messparameter 

Winkelbereich und 
Messauslösung: 

Gesamter Halbraum mit 1° x 1° Winkelauflösung entsprechend IEC 
60809:2021, Anhang K.1 

Stabilisierungsphase: Mindestens 30 Minuten. Zeitfenster für Stabilitätskriterium 15 Minuten. 
Automatischer Start, wenn Stabilitätskriterium von 0.2% (innerhalb 12 
Minuten Zeitfenster) erreicht wird oder spätestens nach 40 Minuten. 

Messdauer: 0:50 h 

Prüfspannung: 12 V DC 

Stabilisierungsphase 
Während der Stabilisierungsphase wird die Beleuchtungsstärke kontinuierlich gemessen. Das 

Stabilisierungskriterium wird aus der minimalen und maximalen Beleuchtungsstärke innerhalb eines 

wählbaren Zeitfensters ermittelt. Nach dem Erreichen der minimalen Stabilisierungsdauer erfolgt der 

Start der Messung automatisch, wenn der gewählte Stabilitätsschwellwert (hier 0.2%) erreicht ist. 

Der Verlauf der Stabilisierungsphase (Abbildung 10) zeigt, dass ab ca. 25 Minuten bis zum Erreichen 

der maximalen Stabilisierungsdauer ein konstanter Wert von 0.4% erreicht wird. 

 

Abbildung 10: Stabilisierungsphase 

mailto:info@technoteam.de


 

Application Note 

 

 

E-Mail: info@technoteam.de Website: www.technoteam.de 5 

 

Messergebnisse 
Das Ergebnis der Messung ist eine TTL-Datei (TechnoTeam Lichtstärkeverteilung) und eine TTR-Datei 

mit den Strahlendaten (siehe folgendes Kapitel). Auch wenn die Lichtstärkeverteilung und der 

Lichtstrom für die Bestimmung des Lichtschwerpunktabstands nicht relevant sind, sollen die 

Ergebnisse an dieser Stelle kurz aufgeführt werden. Der Lichtstrom wurde zusätzlich bei 13.5 V und 9 

V gemessen, um eine Aussage über die Einhaltung der Toleranzen zu erhalten. 

Prüfspannung Lichtstrom Sollwerte (LY5B)1 

9 V 136 lm Mindestens 55 lm 

12 V 224 lm - 

13.5 V 248 lm 224 lm … 336 lm 

Tabelle 1: Gemessene Lichtströme 

Ein Schnitt der Lichtstärkeverteilung wird in Abbildung 11 gezeigt. 

 

Abbildung 11: Lichtstärkeverteilung (Schnitt) 

Vorbereitung der Strahlendaten 
Die Strahlendaten wurden in der TTR-Datei gespeichert. Diese Datei enthält die Rohdaten der 

Strahlendatenmessung, die mit dem Programm Konverter801 von TechnoTeam [4] in diverse 

Strahlendatenformate konvertiert werden kann. Weiterhin ist eine Berechnung des 

Lichtschwerpunkts möglich. Zuvor müssen noch verschiedene Einstellungen und Auswertungen 

vorgenommen werden. 

Öffnen der TTR Datei 
Die TTR Datei wird mit Menüpunkt Datei -> Öffnen geladen. Es öffnet sich eine Übersicht der 

enthaltenen Messparameter und Messergebnisse. Dieses Fenster wird geschlossen. 

Festlegen der Zielgeometrie 
Wie zuvor erläutert, ist die Ausgleichsrechnung mit der quadratische Bewertung der Abstände 

empfindlich gegenüber „Ausreißern“ in den Messdaten. Auf Strahlendaten übertragen sind das 

Strahlen, die z.B. durch Rauschen oder andere Störquellen weit außerhalb der Lichtquelle liegen. Es 

                                                           
1 entsprechend Sheet L5/1 R.E.5 [3] (Production light sources) 
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empfiehlt sich daher, diese nicht zugehörigen Strahlen durch die Festlegung einer Hüllfläche um die 

Lichtquelle herum auszuschließen. Alle für die Ausgleichsrechnung verwendeten Strahlen müssen 

diese Hüllfläche schneiden. Die Hüllfläche wird als Zielgeometrie bezeichnet. 

Bei der Festlegung der Zielgeometrie muss eine ausreichend Platz um die reale 

Lichtquellengeometrie herum gelassen werden, damit es nicht zu einem Ausschließen von relevanten 

Strahlen kommt. Die Lichtaustrittsfläche der gemessenen Lampe kann als flache Kreisscheibe mit 

einem Durchmesser von 8 mm und einer Dicke von 2 mm vereinfacht werden. Die 

Lichtaustrittsfläche liegt etwa bei 3 mm oberhalb der x/y-Ebene (siehe Abbildung 9). Die Einstellung 

der Zielgeometrieparameter erfolgt im Menü Options -> Target geometry. Als Geometrietyp wird 

Cylinder ausgewählt. Mit der Schaltfläche Settings öffnet sich der Dialog für die Geometrieparameter 

(Abbildung 12). 

 

Abbildung 12: Geometrieparameter 

Der Radius wird mit 4 mm und die Länge mit 2 mm angegeben. Die Zylinderachse ist Z. Die 

Verschiebung der Zielgeometrie auf die Position der Lichtaustrittsfläche erfolgt mit dem 

Translationsparameter Tz = 3 mm. 

Zur Überprüfung der Parameter ist es ratsam, eine Strahlendatei, z.B. eine LightTools .ray Datei, zu 

generieren. Dazu wird der Menüpunkt Transform -> LightTools ray file (*.ray) aufgerufen. Eine 

Strahlenanzahl von 1 Million Strahlen ist ausreichend (siehe Abbildung 13). Mit der Schaltfläche Start 

und der Wahl eines Dateinamens wird der Vorgang gestartet. 
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  

Abbildung 13: Generieren eines ray files 

Am Ende des Konvertierungsvorgangs vergleicht man die Zahl der exportieren Strahlen mit der 

vorgegebenen Zahl. In diesem Beispiel wurden 99.92% der Strahlen von der gewählten Zielgeometrie 

„eingefangen“, der Rest sind unerwünschte Strahlen, die somit nicht in der Zieldatei enthalten sind. 

Die akzeptable Grenze für den Anteil der ausgeschlossenen Strahlen hängt vom Messobjekt bzw. 

vom Messaufbau ab. Falls eine Lichtquelle auch seitlich abstrahlt und es dort ggf. zu mitgemessenen 

Reflexionen an der Platine oder anderen Komponenten kommt, kann der Anteil durchaus mehrere 

Prozent betragen. Im Fall dieser Art von Signallampen, ist nicht mit solchen Effekten zu rechnen, so 

dass der Anteil der ausgeschlossen Strahlen kleiner als 1% betragen sollte. 

In manchen Fällen kann es interessant sein, nach der Quelle der ausgeblendeten Strahlen zu 

forschen. Es besteht die Möglichkeit, diese Strahlen ebenfalls ein eine Datei zu schreiben und mit 

Hilfe von Raytracing auf eine Ebene zu Transformieren. Die Beleuchtungsstärkeverteilung der 0.08 % 

ausgeblendeten Strahlen ist in Abbildung 14 dargestellt. Es ist ersichtlich, dass ein Großteil dieser 

Strahlen durch Reflexion an zwei Lötstellen verursacht wird, der Rest ist Streulicht. 
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Abbildung 14: Ursprung der ausgeblendeten Strahlen (links: Beleuchtungsstärkeverteilung in logarithmischer Skalierung, 
rechts: Kamera-Justagebild mit Kreisregion, Durchmesser 8 mm) 

Einbetten der Parameter in die TTR Datei 
Die bisher vorgenommenen Einstellungen der Zielgeometrie sind bisher nur in den aktuellen 

Einstellungen des Konverter 801 Programms gespeichert. Es ist empfehlenswert, diese Parameter in 

die TTR Datei zu übernehmen, damit ggf. zu einem späteren Zeitpunkt auf diese zurückgegriffen 

werden kann. Das Übernehmen der Parameter erfolgt im Edit Modus (File -> Edit). Im ersten Tab 

„Details of measurement“ wird auf die Schaltfläche neben „Take global settings“ geklickt (siehe 

Abbildung 15). Mit dem Schließen des Dialogs erfolgt das Speichern der TTR Datei. 

  

Abbildung 15: Übernahme der Geometrieparameter in die TTR Datei 

Berechnung des Lichtschwerpunktabstands 
Dieser Algorithmus wird über den Menüpunkt Tools -> Calculate the center of gravity of rays 

aufgerufen (siehe Abbildung 16). Mit der Option Use target geometry … from TTR source file erfolgt 

die Übernahme der in der TTR Datei eingebetteten Parameter. Für die Anzahl der Strahlen ist nach 

IEC 60809:2021 1 Million ausreichend. Die Schaltfläche Proceed startet die Berechnung. 

 

Abbildung 16: Berechnung des Lichtschwerpunkts 

Das Ergebnis wird im Ausgabefenster angezeigt. Der gesuchte Lichtschwerpunktabstand e ist hier die 

Z Koordinate des Lichtschwerpunkts. Das Ergebnis ist e = 2,996 mm. Entsprechend R.E.5 [4] ist die 
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Toleranz +/- 0.3 mm für „Production LED light sources“ und +/- 0.15 mm für „Standard LED light 

sources“. Toleranzen für die ebenfalls berechneten x und y Koordinate des Lichtschwerpunkts 

werden in den Normen nicht aufgeführt bzw.. Hier liegen sie mit -0,02 und -0,12 mm sehr dicht an 

der Symmetrieachse der Lampe. 

Bei Berücksichtigung aller Strahlen, also auch der durch Reflexionen und Streulicht gemessenen 

Strahlen, ist der Lichtschwerpunktabstand e = 2,999 mm. In diesem Fall wäre der Einfluss daher 

vernachlässigbar. 

Betrachtungen zur Messunsicherheit 

Die in der R.E.5 [4] genannten Toleranzen von +/- 0.3 mm bzw. +/- 0.15 mm stellen hohe 

Anforderungen an die Messtechnik und den Messaufbau. Eine wünschenswerte Messunsicherheit 

wäre 1/10 davon, also 15 µm. Wesentliche Beiträge zur Gesamt – Messunsicherheit sind: 

 Genauigkeit der Positionierung im Goniometer (Referenzebene) 

 Messunsicherheit der Strahlendaten (beinhaltet auch Effekte durch mangelnde Wartung des 

Messgerätes) 

 Streulicht/Reflexionen 

 Auflösung des Objektivs 

Zur Abschätzung der Messunsicherheit der in dieser Application Note durchgeführten Messung 

werden folgende Parameter berücksichtig. 

 RiGO801 – LED: 

o Toleranz des Koordinatenzentrums bzw. der Strahlkoordinaten im Zentrum: +/- 10 

µm 

o Fehler des Koordinatensystems (Skalierung): < 0.25 % -> auf 3 mm = 7,5 µm 

o Auflösung des verwendeten Objektivs: 35 µm/Pixel 

 Positionierung im Goniometer (Referenzebene): +/- 35 µm 

Eine simple Addition der maximalen Toleranzen ergibt ca. +/- 50 µm. Einen wesentlichen Betrag 

liefert die relativ geringe Auflösung des Objektivs, die zu einer großen Unsicherheit der 

Positionierung der Lichtquelle führt, so wie sie hier durchgeführt wurde. 

Daher empfehlen sich für Messungen im produktiven Einsatz folgende Maßnahmen. 

 Verwendung eines Objektivs mit kleinerem Bildfeld und damit höherer Auflösung. Das Makro 

Standardobjektiv hat ca. 10 µm/Pixel. 

 Präzise Messfassung mit Hilfsmitteln zur exakten Ausrichtung unter Verwendung des 

Makroobjektivs. 

 Korrektur der Koordinatensystemskalierung 

 Referenznormal verwenden 

Zusammenfassung 

Im Rahmen dieser Application Note wurde gezeigt, wie man mit wenig Messaufwand den 

Lichtschwerpunktabstand einer Automotive Signallampe aus Strahlendaten entsprechend der 

Anforderungen der IEC 60809:2021 bestimmen kann. Es wurden viele Praxistipps und mögliche 

Fehlerquellen bei der Messung bzw. Verarbeitung der Strahlendaten erläutert.  
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Das Nahfeldgoniophotometer RiGO801 – LED eignet sich sehr gut die Messaufgabe. Die Messdauer 

bei einer hohen Winkelauflösung von 1° x 1° ist aufgrund der kontinuierlichen on-the-fly Messung 

sehr gering und damit Praxistauglich. Das Messverfahren hat sich bereits mehrfach in der Industrie 

bewährt. 

Das Nahfeldgoniophotometer ist auch für zusätzliche Messungen geeignet. So werden 

standardmäßig auch der Lichtstrom und die Lichtstärkeverteilung gemessen. Eine Auswertung der 

Leuchtdichteverteilung für bestimmte Lampentypen entsprechend IEC 60809:2021, Anhang L.2 ist 

ebenfalls möglich. 
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